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Note for Mac users

Some keystrokes and menu items are different on a Mac from those used in Windows and Linux.
The table below gives some common substitutions for the instructions in this chapter. For a more
detailed list, see the application Help.

Windows/Linux Mac equivalent Effect

Tools - Options menu LibreOffice - Preferences  Access setup options

selection

Right-click Control+click Opens a context menu

Ctrl (Control) ¥ (Command) Used with other keys

F5 Shift+¥+F5 Opens the Navigator

F11 F+T Opens the Styles & Formatting window

Documentation for LibreOffice is available at www.libreoffice.org
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Introduction

You can enhance the functionality of LibreOffice with extensions.

Just install these small programs into LibreOffice and, after restarting efthe office suit, you can
enjoy the new fabcilities.

If you are an extension developer, you can use several languages to develop LibreOffice
extensions. Supported programming languages are Basic, Python, JavaScript and Java. For thea
higher level of integrity and pessibilitiesfunctionality you can use_the C++, Python and Java
languages to develop UNO complements--based extensions.

As a-UNO components, you can provide new implementations of existing functionality or
specialized components like Calc Add-Ins, Add-Ons, DataPilots, Chart Add-Ins, or linguistic
components: Spellchecker, Hyphenator or Thesaurus.

Also you can packcreate extensions fto_provide additional Templates, Gallery images and
Autotexts.

LibreOffice remains committed to providing users with quality software authored under free
software licenses, and, as such, our catalogae of extensions and templates areis published under
free software licenses. These extensions are free of charge.

This hew-temanual describes the basic steps for publishing an extension in the LibreOffice official
extension repository, located at http://extensions.libreoffice.org/.

We recommend te-reading this document before_you starts to publish your extension,: Sespecially
to gather the basics information_you will need to fill the mandatory fields.
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Create a Software Project

First of all, you need to register yourself at the Extensions website. Open the Extensions web site
in your browser and click on the Register button, in the right upper corner. Fill the Registration
form and click Register.

Search

R
D _IUTE Registration form

The Docunll . n
Enter full name, e.g. John Smith.

[30hn Smith |

firrent section

User Name =
Enter a user name, usually something like ‘jsmith’. No spaces or special characters. Usernames
and passwords are case sensitive, make sure the caps lock key is not enabled. This is the name
used to log in.

[jsmitn s

E-mail =

lereOfflce Enter an email address. This is necessary in case the password is lost. We respect your privacy.
and will not give the address away to any third parties or expose it anywhere.

You are here: Home

LibreOffice offers a | be extensions and
templates that add tha gople, maybe you,
can de\,relop more ex A URL will be generated and e-mailed to you; follow the link to reach a page where you can ates go to
http:/itemplates-test.li change your password and complete the registration process.

. Type the code m
Extensions Type the code from the picture shown below.

LibreOffice Extensions are ff (SERE shadﬂ add new functionality to

your copy of LibreOffice, or

[js mithi@test.com

Register

LibreOffice remains committel Of extensions and templates

are published under free software
| You should receive and e-mail containing a link to set your password and complete your
registration process. You may set the password before the deadline date indicated in the e-mail.
\ After this date, you may use the “Forgot your password” link to get a nerw password.

Search Site Search

Welcome!

You have been registered.
You will receive an e-mail shortly containing a URL that will allow you to set your password.
‘When you receive this e-mail, please follow the link to complete your registration process. NOTE:

The password reset URL will expire on Aug 18, 2011 03:15 PM. If your password reset request
expires, you may use the "Forgot your password” link to generate another password reset
request.

You are here: Home b

LibreOffice Extensions

LibreOffice offers a wide variety of features, and when you look for additional functionality, there may well be extensions and
templates that add that! This site offers a wide range of extensions to satisfy your needs. What's more: people, maybe you,
can develop more extensions and offer them for the collecting on this site. If you are searching for templates go to
htip:/ltemplates-test.libreoffice.org or htip:/ltemplates.libreoffice.org.

Extensions

LibreOffice Extensions are tools that can be added or removed independently from your installation of the main program. Extensions may add new functionality to
your copy of LibreOffice, or may make existing functionality easier to use.

LibreOffice remains committed to providing users with quality software authored under free software licenses, and, as such, our catalogue of extensions and templates
are published under free software licenses.

\ After your registration process_is complete, you will be able to log_in and create a new extension
project.
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In the right upper corner, click on Log in to start.

English Francais Deutsch Italiano Portugués Espaniol Log in Register

Search

firrent section

Y Libré Login Name |

The Docu

Password l

Log in
Forgot your password?

If you have forgotten your password, we can send you a new one.

You are here: Home New user?

If you do not have an account here, head over to the registration form.
LibreOffice Exti

LibreOffice offers a wide variety of features, and when you look for additional functionality, there may well be extensions and
templates that add that! This site offers a wide range of extensions to satisfy your needs. What's more: people, maybe you,
can develop more extensions and offer them for the collecting on this site. If you are searching for templates go to
http:/itemplates-test.libreoffice.org or http:/itemplates.libreoffice.org.

Extensions

LibreOffice Extensions are tools that can be added or removed independently from your installation of the main program. Extensions may add new functionality to
your copy of LibreOffice, or may make existing functionality easier to use.

Next, click on Extension Center and, after_that, on Submit your Extension, on the right-green
block to the right.

[search site [search|
M LibreOffice | EXTENSIONS & "o

The Document Foundation

Home Extension Center Help-Downloads

You are here: Home » Extension Center

Contents Edit  Sharing Actions v Display v Add new... v State: Open for submis:

Extension Releases

[ All categories o ] [ LibreOffice 3.4.1 ¢ ] Sort On
[ Highest Rated & ] [ ] [Sean:h]

No results were found.

=p Submit your Extension

=

The Add Software Project form will appear.
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\ In this form, you have some mandatory fields atin the Default tab: Title, Categories, Project
Summary, Full Project Description and Contact address. Each one has a short description
below the field name.

Home SLENELL N Help-Downloads

You are here: Home » Extension Center s [--]

Add Software Project

Default « Metadata Distutils  Review
Title m

[Fixed values for Calc

Categories m
Categories that this item should appear in. h‘

Extensions for all program modules
Gallery Contents for all program modules
Language Tools for all program modules
Writer-Extensions

Imnress.Fytensinns

Project Summary =
A short summary of the project.

(e }

Caution

This extension creates two menu items in Calc to insert current date or current time in the selected cell as a fixed value.

It is not recommended to use special characters like ">>", "<<", "&", "¢", "é" or
semeanything similar in the Title field. Please use only plain English text.

In Categories, you can select more than one option by pressing Ctrl.

| You can see thea list of categories_and their explanation atin the table bellow.

Categories

Description

Example

All modules

Extensions for all program modules

Extensions that could be used with anyH
program modules.

Gallery Contents

Extensions for all program modules

Pictures, Backgrounds, ...

Language Tools

Extensions for all program modules

Dictionaries and similar

Writer

Extensions for Writer

Extensions that could be used to extend the
word processor module.

Calc Extensions for Calc Extensions that could be used to extend the
\ spreadsheet pregram-module.

Impress Extensions for Impress Extensions that could be used to extend the
\ presentation pregram-module.

Draw Extensions for Draw Extensions that could be used to extend the
\ drawing pregrarm-module.

Base Extensions for Base Extensions that could be used to extend the
\ database pregram-module.

Math Extensions for Math Extensions that could be used to extend the

pregram-module for formula.

In Contact address, Use mailto: prefix for e-mail contact or http.// prefix for a external web site.
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In the next table, the Add Software Project form fields are listed.

Field Description
Title Title of the software project.
Categories Categories that this item should appear in.

Project Summary

A short summary of the project.

Full Project Description

The complete project description.

Contact address

Contact address for the project. Use mailto: or http:// prefix
depending on what contact method you prefer.

Home page

If the project has an external home page, enter its URL.

URL of documentation repository

If the project has externally hosted documentation, enter its
URL.

URL of version control repository

If the project has a code repository, enter its URL.

Issue tracker URL

If the project has an external issue tracker, enter its URL.

Support mailing list or forum URL

URL of mailing list information page/archives or support
forum, if the project has one.

Logo Add a logo for the project (or organization/company) by
clicking the 'Browse' button. Max 150x75 pixels (will be
resized if bigger).

Logo link The URL the logo should link to, if applicable.

Screenshot Add a screenshot by clicking the 'Browse' button. Max

800x600 (will be resized if bigger).

\ After filling in the form, click Save.

Please be-awmake sure that the Language field on the Metadata page of your project
is Language neutral! Otherwise the project wills not_be visible ftor users with another
language setting in their browser.

Caution

A
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Your Extension project will be created. However, at this time, you can not add releases,
| documentation or feature proposals. BefereTo achieve that, you need_to submit your project for
approval.

To do this, click on State: Submit for approval link, in the right side of the green bar.

Home SENELL el Help-Downloads

& Fixed values for Calc You are here: Home » Extension Center » Fixed values for Cak

# Releases Contents i Actions » Display + Add new... » State: Unapproved project
Fixed values for Calc
by Gustavo Pacheco — lastmodified Aug 11, 2011 04:05 PM é Like
This extension creates two menu items in Calc to insert current date or U q
current time in the selected cell as a fixed value. 0 likes, 0 dislikes

You can not add releases, documentation or feature proposals until the project itself is approved, make sure you submit it
for approval when the relevant project information has been entered.

Project Description s
Adfter the installation, just go to Insert > Fixed Values menu and choose Date or Hour. The date or hour should be put on

the selected cell, with the default format defined by the cument language.

Current Release
Mo stable release available yet.

All Releases

Version Released Description Compatibility License Status

The status of your project will be changed to State: Pending approval, until ithe_is approvedat by
a reviewer. It is possible that the approval will take a few days.

After approval, the status will be changed to State: Public and you can add releases
documentation and feature proposals.

You will not be notified about the project approval. You should verify the project
status at the website.
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Adding a Release section

| After approval, go to Add new > Release section to create a new workspace for your releases
information and files.

Home Extension Center [EEEEIE R IENS

& Eived values for Cale You are here: Home » Extension Center » Fixed values for Calkc

# Releases Contents i Actions v Display » Add new... » State: Unapproved project »

. i7" Documentation Section
Fixed values for Calc

¥ Releases Section

by Gustavo Pacheco — lastmodified Aug 11, 2011 04205 PM é Like
This extension creates two menu items in Calc SRR = U ?
current time in the selected cell as a fixed value. 0 likes, 0 dislikes

You can not add releases, documentation or feature proposals until the project itself is approved, make sure you submit it
for approval when the relevant project information has been entered.

Project Description
After the installation, just go to Insen > Fixed Values menu and choose Date or Hour. The date or hour should be put on
the selected cell, with the default format defined by the cument language.

Current Release
Mo stable release available yet.

All Releases

Version Released Description Compatibility License Status

At the Add Releases Section form, on the Metadata tab, you need to set the language to
Language neutral, to have this section visible for all users. Then just click on the Save button.

Home Extension Center Help-Downloads

@ Fied values for Calc You are here: Home » Extension Center » Fixed values for Calc » Releases
# Releases s

Add Releases Section

Fol IET typee fior hold N releases.

Default Metadata

Title
Enter a title for the container

Releases

Description
Enter a description of the container

Existing and upcoming releases for this project.

Caution It is not recommended to use special characters like ">>", "<<", "&", "¢", "é" or

semeanything similar in the Title field. Please use only plain English text.
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The Releases folder will be created and you can add a new release clicking on Add new >

Software Release.

Home Extension Center Help-Downloads

& Fixed values for Calc
¥ Releases
¥ Releases

You are here: Home » Extension Center » Fiked values for Calc » Releases

Add new... v

Cisplay »
¥ Software Release

Edit  Sharing Actions v

Releases

Existing and upcoming releases for this project.

« Back to project page

‘You can not add releases, documentation or feature proposals until the project itself is approved, make sure you submit it
for approval when the relevant project information has been entered.

Mo releases found. Use the Add menu o add releases.
Experimental Releases
Stable Releases

Site Map Accessibility Contact

| Now: you need to fill in the Add Software Release form.

& Fixed values for Calc

# Releases

You are here: Home » Extension Center » Fixed values for Cak » Releases » Releases 1.0 (Unreleased)

Add

Software Release
release of a sofware project, either final or in progress

Default =  Metadata

Version =
This field is also used in the URL of the item, so please don't use spaces and special characters. Also, please do

NOT include the alpha, beta, or release candidate state as this is handled by the workflow. Example: 0.1°,
100

Release Summary =
A short description of the most important focus of this release. Not a version history, but in plain text what the main

benefit of this release is.

First release of Fixed Values for Calc.

Format | HTML | 2

Codename
Codename for this release, if you have one.

[ ]

Full Release Description

[ ;TR R F Y

\ Some fields on_the Default tab are mandatory: Version, Release Summary, License and

Compatibility.

Publishing Extensions in LibreOffice

11



| Al fields of the Add Software Release form are_described on the list bellow:

Field

Description

Version

This field is also used in the URL of the item, so please don't use
spaces and special characters. Also, please do NOT include the
alpha, beta, or release candidate state as this is handled by the
work flow. Example: '0.1".

Release Summary

A short description of the most important focus of this release.
Not a version history, but in plain text what the main benefit of
this release is.

Codename

Codename for this release, if you have one.

Full Release Description

The complete release text.

Changelog

A detailed log of what has changed since the previous release.

Release Manager

Release manager for this release.

Release Manager Contact E-mail

Contact e-mail for Release Manager.

Proposals freeze date

Date after which no more Improvement Proposals will be
associated with the release

Feature freeze date

Date after which no new features will added to the release

(Expected) Release Date

Date on which a final release is expected to be made or was
made

License

Release License: Please examine carefully which license you
choose for your contribution. You can't change it after the
release. The options are:

GPL - GNU General Public License

LGPL - GNU Lesser General Public License

MPL — Mozilla Public License

BSD License (revised)

Public Domain

Other OSI Approved
You need to select at least one licence, but you can choose up to
three.

Compatibility

Tested and working with the selected versions

Associated feature proposals

Related improvement proposals for features going into this
release.

Repository branch

URL of version control repository branch for this release.

\ After filling in the Add Software Release form, click Save.

Caution

A

Please be-awmake sure that the Language field on the Metadata page of your release
is Language neutral! Otherwise the prejeetrelease wills not_be visible ftor users with
another language setting in their browser.

12
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Adding files

Now, after creatinged the Release folder, you have two options for the files of the release: add a
downwloadable file or add a link for an externally hosted file. Theise options are detailed in the
next two sections.

| Adding a downwloadable file
| For the first option, click Add new > Downwloadable File on the green bar.

Home Extension Center Help-Downloads

You are here: Home » Extension Center » Fixed values for Calc » Releases » Fixed values for Cak 1.0.0 (Unreleased)

& Fixed values for Calkc
# Releases i i Actions » Display v Addnew... » State: Unreleased

# Releases 53 Downloadable Fie k
Ch. d.
m e « Extemally Hosted File

Fixed values for Calc 1.0.0 (Unreleased)

This is not a final release. Experimental releases should only be used for testing and development. Do not use these on
production sites, and make sure you have proper backups before installing.

First release of Fixed Values for Calc.

sofware cender.

W Up I e downioad ESEngs of

2858 IS OO d downloadable fles have been added. There

For additional information about this project, please visit the overview page .

Available downloads

There are no available sofware files in this release yet Use the Add menu o add sofware files.

Site Map Accessibility Contact
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Atln the Add Downloadable File form_shown below, you just-have just chosen your extension file in
the File field and need to define the operating system in Plataform field.

Home Extension Center Help-Downloads

@ Fixed values for Calc You are here: Home » Extension Center » Fixed values for Calc » Releases » Fixed values for Calc 1.0.0 (Unreleased) » [-+]

¥ Releases Add Downloadable File

Conains the downloadabde fils for the Release.
Default «  Metadata
File Description

File description. Nomally something like "Product Package’, Windows Installer, - or ‘Events subsystem” if you have
several separate modules. The actual file name will be the same as the file you upload.

File m
Click ‘Browse’ to upload a release file.

|/home/gbpacheco/Area de Trabalho/Anot |[ Enviar arquivo...

Platform = %
List of platforms available for selection

All platforms =

Cancel

At the end of the form, click Save.

Caution Please be-awmake sure that the Language field on the Metadata page of your
downloadable file is Language neutral! Otherwise the project wills not be visible ftor
users with another language setting in their browser.

Leave the File Description field empty. Otherwise the file will have this field for its

name. You may set the file description afterwards on the Contents tab of the release,
//i\ with the Rename button: New Short Name stands for the name of the file whereas
L]

New Title stands for the description of the file.
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Adding a link for an externally hosted file

To add an externally hosted file, just click Add new > Externally Hosted File on the green bar and
fill the Add Externally Hosted File form. For externally hosted files, ©only_ the Plataform and

URL-Fer-externally-hested-file fields are mandatory.

# Releases Add Externally Hosted File

Comts T Release.
Default =«  Metadata

File Description
File description. Mormally something like "Product Package’, "Product Installer, or "Product Bundle® - if you have

several packages in one archive. The uploaded fiename will not be changed.

Platform =
List of platforms available for selection

All platforms % |

URL for externally hosted file =
Please enter the URL where the file is hosted.

[ ]

File size
Please enter the size of the extemnally hosted file, if known. Include the notation kB or MB.

[ ]

Save | | Cancel |

I m [T~

i

Click Save to finish.

Caution Please be-awmake sure that the Language field on the Metadata page of your
downloadablteexternally-hosted file is Language neutral! Otherwise the project wills
not_be visible ftor users with another language setting in their browser.
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Publishing a release

| After addinged a downwloadable file or a link for an externally hosted file for the release, you will
see the Extension release and the file(s).

Home Extension Center Help-Downloads

& Fixed values for Calc
# Releases

¥ Releases

You are here: Home » Extension Center » Fixed values for Calk » Releases » Fixed values for Cale 1.0.0 (Unreleased) »
Fixed_WValues_for_Calc.oxt

Edit Propeies Sharing Translate into... v  Actions »

m Remember to publish your release once all files have been added by going back to the release page . ‘

», Fixed values for Calc 1.0.0 (Unreleased) -
Fixed Values for Calc.oxt

by Gusiavo Pacheco — lasimodified Aug 11, 2011 04:22 PM
First release of Fixed Values for Calc.

# Download (18.3 kB)

Site Map Accessibility Contact

Click on going back to the release page link to change the release status. To publish the release, go to
State: Unreleased menu and define the new state, for example, Release final release.

Home Extension Center Help-Downloads

& Fixed values for Calc
# Releases

¥ Releases

You are here: Home » Extension Center » Fixed values for Calc » Releases » Fixed values for Calc 1.0.0 (Unreleased)

Contents Edit

Sharing Actions » Display » Add new... v State: Unreleased »

Hide release

Fixed values for Calc 1.0.0 (Unreleased)

This is not a final release. Experimental releases should only be used for testing and development.
production sites, and make sure you have proper backups before installing.

Release alpha
Release beta
Release candidate

Release finalleas:e

Advanced...

First release of Fixed Values for Calc.

Policy...

For additional information about this project, please visit the overview page .

Available downloads

Fixed_Values_for_Calc.oxt
For Al plationms (15.3 kB)

Site Map Accessibility Contact

Finally, log out and go to the new extension page to see your extension published!
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